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Allgemeine Einleitung

Allgemeine Einleitung

Draw ist ein Zeichenwerkzeug für Vektorgrafiken. Es bietet eine Reihe mächtiger 
Werkzeuge, die es Ihnen ermöglichen, alle Arten von Grafiken schnell zu erzeugen. 
Vektorgrafiken speichern und zeigen ein Bild als Vektoren (zwei Punkte und eine 
Linie) und nicht eine Ansammlung von Pixeln (Punkte auf dem Bildschirm). Vek­
torgrafiken erlauben eine einfachere Speicherung und Skalierung des Bildes.

Draw ist perfekt in das OpenOffice.org-Paket integriert, was den Austausch von 
Grafiken zwischen allen Komponenten des Paketes erleichtert. Falls Sie z. B. ein Bild 
in Draw erzeugen und es in einem Writer-Dokument wiederverwenden wollen, 
können Sie es einfach hier kopieren und dort einfügen. Sie können auch mit Zeich­
nungen direkt innerhalb von Writer und Impress arbeiten und dort eine Teilmenge 
der Funktionen und Werkzeuge von Draw benutzen.

Draws Funktionsumfang ist sehr reichhaltig und vollständig. Auch wenn es  nicht 
entworfen wurde, um mit spezialisierten Grafikapplikationen zu konkurrieren, 
besitzt Draw weiterhin mehr Funktionen als die Mehrheit der Zeichenwerkzeuge, 
die in Office-Produktivitätspaketen integriert sind.

Ein paar Beispiele aus der Fülle der Zeichenfunktionen wird vielleicht Ihren Appetit 
anregen: Ebenenmanagement, magnetisches Gitterpunktsystem, Dimensions- und 
Maßstabanzeige, Verbinder für die Erstellung von Organisationsdiagrammen, 3D-
Funktionen, die es ermöglichen, dreidimensionale Zeichnungen zu erstellen (mit 
Texturen und Lichteffekten), Integration des Zeichen- und Seitenstils und Bezierkur­
ven, um nur einige zu nennen.
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Der Arbeitsplatz

Der Arbeitsplatz

Die Hauptkomponenten der Draw-Benutzeroberfläche hat das Erscheinungsbild, 
das in Abbildung 1 zu sehen ist.

Abbildung 1. Anfängliches Draw-Fenster

Im großen Bereich in der Mitte des Bildschirms werden die Zeichnungen 
angefertigt. Er ist von Werkzeugleisten und Informationsbereichen umgeben, deren 
Anzahl und Position gemäß der jeweiligen Organisation, die Sie für Ihren 
Arbeitsplatz gewählt haben, variieren kann.
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Die Symbolleisten

Die verschiedenen Draw-Symbolleisten können gemäß Ihren Bedürfnissen ange­
zeigt oder versteckt sein.

Viele der schwebenden Symbolleisten in OOo 1.x wurden in OOo 2.0 zu 
Hauptsymbolleisten.

Anmerkung Um auf eine Symbolleiste zuzugreifen, wählen sie Ansicht > Symbolleis­
ten.

Um die Symbolleisten anzuzeigen oder zu verstecken, klicken Sie einfach auf An­
sicht > Symbolleisten. Im Menü, das erscheint, wählen Sie, welche Symbolleisten 
angezeigt werden sollen.

Sie können auch die Schaltflächen auswählen, die Sie auf der entsprechenden Sym­
bolleiste haben wollen. Im Menü Ansicht > Symbolleisten wählen Sie Anpassen, 
klicken auf den Symbolleisten-Karteireiter (siehe Abbildung 2), und wählen dann die 
erwünschten Schaltflächen für diese Symbolleiste. Jede Symbolleiste hat eine unter­
schiedliche Liste der Schaltflächen.

Viele Schaltflächen der Symbolleisten sind mit einem kleinen Pfeil neben der Schalt­
fläche markiert. Dieser Pfeil zeigt an, dass diese Schaltfläche zusätzliche Funktionen 
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Die Symbolleisten

hat. Klicken Sie auf den Pfeil und ein Untermenü oder eine schwebende Symbolleiste 
erscheint, die ihre zusätzlichen Funktionen zeigt (siehe Abbildung 3).

Abbildung 3 Ein Pfeil neben einer Schaltflä­
che zeigt zusätzliche Funktionen an

Eine ähnliche Funktion hat der kleine Pfeil in der Titelleiste einer (schwebenden) 
Werkzeugleiste. Klicken Sie auf den kleinen Pfeil und Sie sehen zusätzliche 
Funktionen (siehe Abbildung 4).

Abbildung 4. Ein Pfeil auf einer (schwebenden) Werkzeugleiste zeigt zusätzliche 
Funktionen an

Sie wünschen sich vielleicht, dass dieses Untermenü sichtbar auf Ihrem Bildschirm 
bleibt, aber an einer anderen als der Standardposition. Sie können dieses Unterme­
nü in eine schwebende Symbolleiste  umwandeln. Dazu klicken Sie auf die Titelleiste 
des aufgeklappten Untermenüs, ziehen Sie das Untermenü mit gedrückter 
Maustaste über den Bildschirm an die gewünschte Position und geben dann die 
Maustaste frei.

Anmerkung Die meisten Schaltflächen, die mit dem schmalen Pfeil versehen sind, können 
zu schwebenden Symbolleisten werden. Schwebende Symbolleisten finden Sie 
in allen Komponenten des OpenOffice.org-Pakets.

Die Werkzeuge, die in den verschiedenen Symbolleisten verfügbar sind, werden in 
den folgenden Abschnitten erklärt.
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Die Standardleiste
Die Standardleiste sieht folgendermaßen aus:

Sie ist in allen Modulen des OpenOffice.org-Pakets identisch und wird hier nicht im 
Detail beschrieben.

Die Symbolleiste Linie und Füllung
Die Symbolleiste Linie und Füllung, früher die Objektleiste, lässt Sie die Haupteigen­
schaften eines Zeichenobjekts ändern. Die Piktogramme, die angezeigt werden, vari­
ieren abhängig vom Objekt, das ausgewählt ist. 

Im obigen Beispiel ermöglichen Ihnen die Funktionen, Farbe, Stil und Breite der ge­
zeichneten Linie einerseits, und Füllfarbe, Stil und andere Eigenschaften der Fläche 
andererseits des gegenwärtig ausgewählten Objektes zu ändern. Falls das ausge­
wählte Objekt Text ist, ändert sich die Symbolleiste zu der unten abgebildeten.

Die Symbolleiste Zeichnen

Die Symbolleiste Zeichnen ist die wichtigste Symbolleiste in Draw. Sie enthält alle 
notwendigen Funktionen, um die unterschiedlichsten geometrischen und Freihand­
formen zu zeichnen und sie auf der Seite zu organisieren.

Die Farbleiste
Um die Farbleiste anzuzeigen, benutzen Sie Ansicht > Symbolleiste > Farbleiste. 
Die Werkzeugleiste erscheint dann unten am Arbeitsplatz.

Diese Symbolleiste lässt Sie rasch die Farbe des Objekts in Ihrer Zeichnung wählen. 
Das erste Feld im Panel entspricht der Transparenz (keine Farbe).

Die Farbpalette kann, wie es in Abbildung 6 zu sehen ist, geändert werden. Sie errei­
chen sie über  Format > Fläche oder durch Anklicken des Gießkannensymbols 
(roter Kreis) in der Symbolleiste Linien und Füllung, siehe Abbildung 5, und durch 
Anklicken des Karteireiters mit dem Namen Farben.
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Abbildung 5: Menü "Fläche" aufrufen

Wenn Sie die Schaltfläche Farbtabelle Laden anklicken (siehe roter Kreis), fragt 
Sie der Dateiauswahldialog nach einer Farbtabellendatei (mit der Datei­
endung .soc). Mehrere Tabellen werden standardmäßig mit OpenOffice.org 
mitgeliefert. Zum Beispiel ist web.soc eine Farbpalette, die vor allem zur 
Erzeugung von Zeichnungen angepasst ist, die in Webseiten erscheinen 
sollen, da damit die Farben korrekt auf Arbeitsplätzen mit Bildschirmen 
angezeigt werden, die mindestens 256 Farben anzeigen können.

Abbildung 6. Ändern der Farbpalette
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Die Symbolleisten

Die Farbauswahlbox lässt Sie auch individuell jede Farbe durch das Ändern der nu­
merischen Werte in den angebotenen Feldern auf der rechten Seite der Farbtabelle 
ändern. Sie können auch auf Bearbeiten klicken, um ein Dialogfeld angezeigt zu be­
kommen (zu sehen in Abbildung 7), das die Auswahl der Farben erleichtert.

Abbildung 7. Definieren von Farben nach Farbmodellen

Sie können die Farbmodelle, bekannt als CMYK, RGB und HSB, benutzen, um Ihre 
gewünschte Farbe genau zu bestimmen. Eine gute Einführung in Farbmodelle finden 
Sie z. B. unter: http://www.filmscanner.info/Farbmodelle.html.

Die Optionsleiste
Diese Symbolleiste lässt Sie verschiedene Zeichenhilfen aktivieren oder de­
aktivieren. Die Optionsleiste wird nicht standardmäßig angezeigt. Um sie anzu­
zeigen, wählen Sie Ansicht > Symbolleisten > Optionen.

Die Rasterwerkzeuge sind folgendermaßen unterteilt: Fangraster, Führungslinien 
und   Hilfslinien beim Verschieben. Zeichenobjekte können „gefangen“ werden, d.h., 
sie können am Raster, an den Führungslinien, am Seitenrand, oder aber an den 
Objektpunkten oder Objektrahmen anderer Objekte andocken.  
Aktivieren Sie das Raster oder die Führungslinien, um Objekte dort zu fangen. 
Aktivieren Sie die jeweilige andere Schaltfläche, wenn Sie das Objekt anders fangen 
wollen.
Wenn Sie Ihr Zeichenobjekt in die Nähe des Fangpunktes oder der Fanglinie ziehen, 
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Die Symbolleisten

werden Sie sehen, wie es „magnetisch“ angezogen wird.  

Raster sichtbar
Wenn das „Raster sichtbar“ geschaltet ist, erscheint ein Punkteraster, an dem Objek­
te einrasten können. Klicken Sie auf die Raster sichtbar-Schaltfläche in der Sym­
bolleiste Optionen zur Anzeige des Rasters und klicken Sie dann die Am Raster 
fangen-Schaltfläche, um es zu aktivieren. Der Arbeitsbereich wird mit Punkten gefüllt 
sein, wie es in Abbildung 8 zu sehen ist.

Wenn das Raster aktiv ist, können Formen einfach durch den Gebrauch der Punkte 
als ein Wegweiser positioniert werden. Im folgendem Beispiel sind die Griffe des 
Objekts exakt an den Punkten im Raster positioniert.
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Die Symbolleisten

Der Abstand zwischen den Punkten ist im Rasteroptionendialog unter dem Bereich 
OpenOffice.org Draw der OOo-Optionen (Extras > Optionen > OpenOffice.org 
Draw > Raster) definiert, siehe folgende Abbildung:

Im Dialog, der in der Abbildung 12 zu sehen ist, können Sie die folgenden Parameter 
setzen:

• Vertikale und horizontale Abstände der Punkte im Raster. Sie können auch die 
benutzte Maßeinheit ändern.

• Die Auflösung betrifft die Größe der Quadrate oder Rechtecke im Raster. 
Falls die Auflösung Horizontal 1cm, Vertikal 2cm ist, sind die Rechtecke des 
Rasters 2cm hoch und 1cm breit.

• Unterteilungen sind zusätzliche Punkte, die zwischen den Ecken eines jeden 
Rechtecks oder Quadrats im Raster erscheinen. Objekte rasten sowohl an Un­
terteilungen als auch an den Ecken des Rasters ein.

• Die Pixelgröße des Einrastbereichs definiert, wie nah Sie ein Objekt an einen 
Einrastpunkt oder eine Einrastlinie bringen müssen, bevor es dort einrasten 
wird.
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Die Lineale
Sie sollten die Lineale an der oberen und linken Seite des Arbeitsplatzes sehen (sie­
he Abbildung 10), sie zeigen Ihnen mit grauen Balken die Größe des angewählten 
Objekts auf der Seite. Die Lineale zeigen die Stelle der Maus, um Ihnen beim ge­
naueren Positionieren der Objekte zu helfen.

Die Seitenränder im Zeichenbereich werden auch auf den Linealen dargestellt. Sie 
können die Ränder direkt an den Linealen ändern, indem Sie sie mit der Maus zie­
hen. Um die Einheiten der Maße auf den Linealen zu ändern, führen Sie einen 
Rechtsklick auf einem der beiden Lineale aus.

Abbildung 10. Lineale in einer Zeichnung

Sie können auf den beiden Linealen unterschiedliche Einheiten angeben.

Die Lineale werden auch benutzt, um Punkte und Fanglinien zu handhaben, was das 
Positionieren der Objekte vereinfacht.

Die Statusleiste befindet sich unten auf dem Bildschirm. Der mittlere Teil dieses Be­
reiches ist besonders relevant für das Draw-Modul.

Die Größen werden in der gegenwärtigen Maßeinheit angegeben (nicht zu ver­
wechseln mit den Linealeinheiten). Diese Einheit wird in Extras > Optionen > 
OpenOffice.org Draw > Allgemein definiert, wo Sie auch den Zeichnungsmaß­
stab ändern können. 
Das linke Zahlenpaar zeigt Ihnen entweder, wo sich der Mauszeiger befindet oder 
wo die linke obere Ecke eines Objekts ist, wenn ein solches angewählt ist.
Das mittlere Zahlenpaar zeigt Ihnen die Größe eines Objekts.
Die Prozentzahl gibt Auskunft über den Zoomfaktor und kann durch einen 
Doppelklick oder einen rechten Mausklick schnell geändert werden.

Einführung in Draw 10


	Copyright
	Copyright und Lizenzen
	Autoren
	Beitragende
	Veröffentlichung und Softwareversion

	Inhalt
	Allgemeine Einleitung
	Der Arbeitsplatz
	Die Symbolleisten
	Die Standardleiste
	Die Symbolleiste Linie und Füllung
	Die Symbolleiste Zeichnen
	Die Farbleiste
	Die Optionsleiste
	Raster sichtbar

	Die Lineale


